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1.1Program Description
Drag And File streamlines and simplifies the work of managing files on your computer. It 
offers several unique functions, such as a directory finder, a duplicate file finder and a DOS 
command utility.
Drag And File works at several levels of sophistication and integrates with other 
management and utility programs. The result is an uncommon degree of flexibility: Drag 
And File can be configured to meet your needs, your working style, and your experience. 
When you need more, Drag And File delivers. 
Unlike most other Windows file managers, Drag And File allows you to highlight individual 
files and tag multiple files, which makes possible batch operations on non-contiguous groups
of files. 
Drag And File offers a broad range of file management tools:

Drag-and-drop file move, copy, and delete
Viewing of all text and most graphics files
Tree and branch batch operations on all files
Single click execution of most frequent tasks from a toolbar, including viewing
Separate windows for each drive
Full configurable hot key control for hands-on keyboard  execution
Formatting and diskcopying for floppy diskettes
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Main window
Drag And File displays a window complete with toolbar and menu choices for each drive 
selected. You may open up to 12 drive windows simultaneously. 
The entire program can be run from a single small Drivebar which floats unobtrusively on 
your screen. The Drivebar makes complete directory and file information just a mouse click 
away.

Drivebar
Drag And File includes an Uninstaller to remove the program and changes made during 
installation. 
Note:  Microsoft Windows' file-handling requirements may make it necessary for you to delete the uninstaller file 
itself. 

On-line help
The on-line help system is available at any time by clicking on the Help menu on the menu 
bar in the main window. Context-sensitive help is also available for most menus and dialog 
boxes. For information and procedural help specific to a screen or menu, click on the Help 
button.

Telephone help
Canyon Software is committed to producing software that is useful and productive. To help 
users make full use of Drag And File, Canyon Software maintains a technical help line for 
registered users from 8:30 AM to 5:30 PM Pacific Time.
Phone  (415) 453-9779
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Fax (415) 453-6195
BBS (415) 453-4289
CompuServe Go Canyon
America On Line DanBCan

1.3 Installation
Requirements
Drag And File is designed to run on an IBM PC-compatible computer with an 80286 or 
higher processor and a minimum of  2 megabytes (4 is recommended) of RAM. The program
requires 2.5 megabytes of disk space for a typical installation. 

Installation procedures
1.  Power on the computer, load Windows, and open the Program Manager.
2. Insert the Drag And File disk 1 into an appropriate drive.
3. From the Program Manager's File menu, choose Run.
4. In the dialog box, type the designation of the drive in which you inserted the Drag And File program 
disk, 

followed by "SETUP" and press the Enter key.  If the drive is designated B:, the Run command  would 
be 

as follows:
B:DFSETUP

At the initial introduction screen choose OK to continue and the Setup dialog box will appear:

Setup dialog box
5. If installing from a floppy diskette, only the first two options will be available.  Choose one of these 

options. Fileman Launcher is a utility which installs as a drop down menu from the menu bar. It offers 
easy 

access to Drag And View Gold, the file viewer and Drag And Zip, the Zip file manager and other 
auxiliary programs which work with Drag And File.  When you make your choice and click OK, Drag 

And 
File installs automatically.

6. The installation program concludes by opening the newly created Drag And File group window, 
showing 

the icons representing components of the program. 
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Uninstall
To remove Drag And File:

Click on the Drag And File setup icon in the Drag and File group in Program Manager.
The setup screen appears. Follow instructions to remove Drag And File.

Note:   Microsoft Windows' file-handling requirements may make it necessary for you to delete the uninstaller file
itself. 

Configuring 
2.1Setting Preferences
Drag And File offers several ways to tailor the program to meet individual needs. 

Options/Settings
From the Options menu you access the Fonts and Settings dialog boxes, which allow you to 
adjust several aspects of the program's performance and display.
To change fonts:

1. Select Fonts from the Options menu.
The Fonts dialog box displays. Available fonts are those which are installed under Windows, or under a 
type manager working with Windows.

Font options dialog box
2. Make whatever changes you wish and click OK.

The changes take effect immediately and remain when you exit the program.
To change Settings:

1. Select Settings from the Options menu.
The Settings dialog box displays.  The Settings dialog box has four pages that are accessed by clicking the 
mouse on one of the four tabs at the top.  The first page is for general settings.
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Settings page
2. Enter your choices for warnings, multiple windows operations and window appearance.

Overwrite Warnings. When enabled, these warnings appear when the files you are copying or moving 
are about to overwrite files of the same name.   These warnings can always be overridden at copy or move 
time.
Multiple Window Operations. Drag And File lets you perform operations on tagged files in more than 
one window. These choices allow you to specify which operations you would like to perform in multiple 
windows.
When Copy from multiple windows is checked, Drag And File will perform all file copy operations on 
the highlighted file or the tagged files from all open Drag And File windows.
When Move from multiple windows is checked, Drag And File will perform all file move operations 
on the highlighted file or the tagged files from all open Drag And File windows.
When View files from multiple windows is checked, and you choose the view files option from the 
Drag And File tool bar or the “Actions” menu, Drag And File will view the highlighted and tagged files 
from all open Drag And File windows.
When View directories from multiple windows is checked, and you choose the view directories 
option from the Drag And File tool bar or the “Actions” menu, Drag And File will open up a view window 
with the listing of all the files in the highlighted and tagged directories  from all open Drag And File 
windows.
When Drag and drop from multiple windows is checked, all drag and drop operations to other 
programs include the tagged files or highlighted file from all Drag And File windows.  Drag And Drop 
operations to toolbar buttons will depend on the configuration for the action of the particular button.  For 
example, if you have Drag And File configured to copy from only the active window, dragging files to the 
copy button will only work on the active window no matter what you have configured for drag and drop.
When Zip file from multiple windows is checked and you click on the zip button on the toolbar, the 
highlighted file or the tagged files in all the open Drag And File windows will be put in the resulting Zip 
file.
Window Appearance. These choices follow the pattern for Microsoft Windows: cascaded windows are 
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overlapped slightly, and tiled windows are fully visible.

Programs page
3. In the programs page enter the names of auxiliary programs that you can run with Drag And File.  Drag 

And File will try to fill in these options automatically when it is installed.
Compression Programs.  Drag And File comes with built-in routines to perform PKZIP 2.04 
compatible zipping and unzipping.  However if you’d rather use an external copy of PKZIP or use LHA or 
GUNZIP you can enter their locations here.  You will notice a “Browse PKZIP” button on the right hand 
side of the dialog.  The legend of that button will change to “Browse LHA”, “Browse GUNZIP”, and so on 
depending on which field is active.  Choosing the browse option will enable you to browse through files 
and directories to find the program location.
WWW Browser.  If you like to access World Wide Web sites on the Internet, you’ll be glad to know that 
Drag And Zip, the compression management program that comes with Drag And File, is designed to work 
seamlessly with many Web browsers like Mosaic and Netscape.  When you download a Zip, LHA or GZ 
file from the net, Drag And Zip’s zip file manger will automatically pop up and allow you to extract, view 
or scan the compressed file for viruses.  All you need to do is enter the name and path or your Web browser 
in this field.
Editor.  Enter your editor of choice in this field and you can edit a highlighted file when you choose the 
edit file option.
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Drives Page
4. In the drives page you can configure the drives that are available to Drag And File.  This is particularly 

useful on networks where you might want to limit the drives available to different users.  The settings in 
this dialog box will be reflected in both Drag And File and the Drag And File Drive Bar.
Select the drives that you want to have available.  To make drive selection easier, there are check boxes 
where you can turn on or off the different drive types.  Drives that have been selected will be displayed 
below the drive list box.
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Viewer Page
5. In the viewer page you are configuring the viewer program Drag And View Gold.  Drag And View Gold 

comes as part of Drag And File.
Check the View highlighted file automatically box to have the view window automatically view each 
newly highlighted.  If a view window is not already open and you want one opened automatically, check 
Open view window if necessary.  The third option, Bring view window to top, will bring the view 
window to the top whenever a new file is selected.  Autoview will only work if there are no files tagged.
Drag And View Gold runs as an icon on the bottom of your screen.  You can change the behavior of how it 
runs, change the icon caption and even hide the icon by choosing the configurations options in this page.
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Zipper Page
6. Choose the Zipper page to configure Drag And Zip.  Drag And Zip is the compression file manager that 

comes with Drag And File.
Like Drag And View Gold, Drag And Zip runs as an icon on the bottom of your screen.  You can modify 
how the icon runs, change the caption and hide the icon from this page.  
Built-in Zipping.  The default operation of Drag And Zip is to use it’s built-in zipping and unzipping to 
manage zip files.  You can also have it use an external copy of PKZIP by seeing that this option is not 
checked.  If you are using an external copy of PKZIP, you should make sure you know what version you 
are using and see that the PKZIP Version 2 or Greater box is checked appropriately.  When Drag And 
File is configured, it will try to determine this automatically.
Output Directory.  When you compress files or extract files from a compressed file, you need to enter a 
directory where you can put the file or files.  You can choose to have this default to either the current 
directory or the directory where you previously placed the files.
Drag And Zip allows you to modify its display to show you the information that you are interested in 
knowing.  When viewing the contents of a Zip or LZH file you can choose to either display any saved path 
information or the CRC (cyclic redundancy check) of the compressed file.

7. Click OK to save your changes and exit. Click on Cancel to exit without making changes.

Configure Toolbar
Drag And File’s button toolbar is very easily modified allowing you to add and delete 
different buttons.  Programs can also be added to toolbar buttons.  All toolbar buttons can be 
configured to user Alt or Ctrl key combinations as hot keys.  Alt hot keys are shown in the 
lower right of the button as black on gray.  Ctrl hot keys are shown as white on black.  There 
is also an option to completely hide the toolbar.  If the toolbar is hidden, the configured hot 
keys are still active.
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To modify the toolbar:

1. Choose Customize Toolbar from the Options menu.
The Toolbar Customize dialog appears:

Toolbar Customize dialog
In the list box on the left appear the available button choices.  The top two entries are SEPARATOR and NEW 
PROGRAM.  SEPARATOR adds a space between two buttons.  NEW PROGRAM allows you to install a 
program as a button choice.  In the list box on the right appear the buttons that are currently part of the toolbar 
along with their hot keys.  

To add a new button
1 Select the position in the Toolbar buttons list box where you want the button to appear.  The new button 

will appear before the selected button.  You can also drag buttons in the Toolbar buttons list box to modify 
their position.

2. Select the button that you want to add from the Available buttons list box.  You can also choose 
SEPARATOR or NEW PROGRAM.  If a command button is already in the Toolbar buttons list box, it 
won’t be in the Available buttons list.

3. Choose Add or drag the button to the right hand list box.  The button will be added.
To remove a button

1. Select the button that you want to remove from the Toolbar buttons list box.  Click on Remove or drag the 
button to the left hand list box.  The button will be removed.

To add a program
1. Select NEW PROGRAM and choose Add.  The Add Program dialog will appear.
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Add Program dialog box
2. Browse through the directories and files and pick the program that you want to associate with the button.  If

you want the file that’s currently highlighted to be launched with the program check the Launch 
Highlighted File With Program box.  When the mouse cursor is over any of the toolbar buttons, a little 
window will come up saying what the button does.  You can enter a custom button description in the 
Button Description field.  If no description is entered, the program name will be used.

3. Choose OK and the button will be added to the Toolbar buttons list box.  If the program has an embedded 
icon like most Windows programs, that icon will be placed on the button.

To modify a program button
1. Highlight the button in the Toolbar buttons list box.  Choose the Program button and the Add Program 

dialog will appear.  Follow the directions for adding a program.
To add or change a button hot key

1. Highlight the button whose hot key you want to change or add.  Select the letter of the hot key that you 
want to use from the drop down list box in the lower right of the Customize Toolbar dialog box.  Choose 
Alt or Ctrl if you want the hot key to use the Alt key or the Ctrl key.  

When you are finished making changes to the toolbar, choose OK.  All changes will be saved
and windows updated.  If you choose a hotkey that is already in use, you will be warned 
before saving the new hot key.

2.2Auto-configure
Auto-configure preserves changes to the next session of the program. Changes you make in 
the Settings dialog box from the Options menu, or changes in the dimension of the drive 
windows you make by clicking and dragging the borders, are automatically saved and remain
in effect as the default choices when the program runs again.

2.3Drag And File Drivebar
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About the Drivebar
Though small and unobtrusive, the Drag And File Drivebar can provide access to all your 
Drag And File functions.
The Drivebar consists of a floating bar containing buttons which represent your drives, 
removable and fixed drives, local and networked, and a control bar. Click on a drive button 
to open a new drive window. Click on the control bar to open a menu with choices to control 
the Drivebar display and to close all open Drag And File windows.

Drivebar
The DF Drivebar normally floats in the foreground, above whatever application is current.
Using the Drivebar
To activate the Drivebar, open the Drag And File group window from Program Manager and 
click on the DF Drivebar icon. 

Drivebar icon
Configuring the Drivebar
The  Drivebar can be altered to fit your needs. 
To configure the Drivebar:

1. Click on the control bar in the upper left corner of the DF Drivebar icon bar.
The control menu appears.

Drivebar control menu
2. Click on Display Vertically (or Display Horizontally) to select the configuration other than the

one currently in effect.
3. Click on Always Visible to make the Drivebar appear on top of other programs.
4. Click on Close All Drag And File Windows to close all open Drag And File drive windows, but 

leave the Drivebar icon visible.
5. Click on other choices as needed to Move, Close, open a Help window, or to see information about the 

Drivebar.

System bar
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2.4Fileman Launcher
Fileman Launcher is a utility that helps to manage all your Drag and File auxiliary programs,
such as Drag And View Gold. Fileman Launcher is installed as an option when you install 
Drag And File, and a menu of its choices is accessible by clicking on Fmlaunch in the Drag
And File menu bar.

Fmlaunch menu
Using the Fmlaunch menu you can do the following: 

Add and delete items to the list programs that Fileman Launcher runs.
(Fileman Launcher can run up to 12 programs with Drag And File)
Change how the programs are run 
Add command line arguments to the programs
Quit all the programs 
Rerun the programs

Using Drag And File
3.1Drag And File Main Window
The Drag And File window is divided into several functional and information sections. Drag 
And File can open up to twelve windows simultaneously.
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Drag And File main window
The menu bar contains drop down menus. They are accessible with a mouse or directly from 
the keyboard by using the Alt key in combination with the underlined letter or arrow keys.
The information sections contain data about the drive currently displayed, number of 
directories on this drive, the space remaining on the drive, the  files in the selected directory, 
and their total size.
Note: Drive data may be incorrect for compressed drives.
The drive buttons allow you to choose which drive information the open window displays. 
Double clicking on the icon of the currently displayed drive opens a second window 
displaying that drive.
The lower half of the window is divided into two panes: information in the left pane 
concerns directories, and information about files appears in the right pane.
Choosing files and directories
Drag And File, unlike Microsoft Windows File Manager, allows you to select and work with 
directories in the same way that you select and work with files.
Drag And File marks files and directories by highlighting, tagging, and dotting.
· Highlight files and directories by left clicking on them with the mouse, or by using the 

arrow keys to move the highlight bar up or down over a listing. Only one directory or file
can be highlighted at a time. Operations like Copy or Move can be performed on a 
highlighted file by clicking the appropriate tool, or by using drop down menus or 
keyboard shortcut keys. If any files are tagged, highlighting is ignored.
Tag and untag files or directories by several methods:
Right click with the mouse to tag and untag; Shift-Left click to tag contiguous groups of files or directories.
Right arrow to tag; left arrow to untag.  ( This method is not available when viewing filenames only )
Spacebar and Ctrl-Right click to toggle tagging on or off.

· Ctrl+Left Arrow or Slash tag all files or directories
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· Ctrl+Right Arrow or Ctrl+Slash untag all files or directories

Dots mark files which have been copied. Dotted files may be reselected as a group for 
other operations.

Menu Bar
The menu bar contains the headers for the main drop down menus. Most menus include 
information about shortcut key combinations to activate commands from the keyboard.
Drag And File includes in its menu bar extensions—drop down menus inserted in the File 
Manager's menu bar by utility and other programs. Examples include the Stacker file 
compression program, and the Microsoft Backup, anti virus, and DoubleSpace programs.
Drive bar
The drive bar includes buttons that represent all accessible drives.  Click on a drive button to 
change to that particular drive.  Double click on a drive button to open a new Drag And File 
window for that drive.  Additionally, files can be dragged to the drive buttons for copying or 
moving.
Toolbar
The toolbar displays a series of buttons that activate tools or shortcuts.
Directory pane
The directory pane displays, in a tree format, all directories and subdirectories of the 
currently selected drive.
File pane
The file pane displays a list of the files and their attributes contained within the currently 
selected directory or subdirectory.

3.2Type to File/Directory function
To locate a specific directory or file, when the appropriate pane is active, start typing the 
name of the directory or file. Your typing appears in a small window that opens over the 
directory count in the lower left corner of the window, beneath the directory pane. As you 
type, the highlight bar will move to the directory or file which most closely approximates 
your typing.


